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Product line & Licensing (1/2)

e Online licensing system
— Rapid turn-around — purchase / update
— Local admin privilege is not required
— Off-line activation is possible
— Easy to move a licence
— TSG Dongles are supported



Product line & Licensing (2/2)

e Licensed modules

Old name New name Modules

TSG Lite discontinued discontinued

TSG Pro, Core, | TSG Stats + Core + HotCore
HotCore and

Enterprise

TSG-Viewer TSG-Viewer N/A

e QC and Viewer are named as before
e Core now includes “HotCore” functionality



TSG8 compatibility

e TSG7 cannot open a dataset that has been
created or modified by TSG8

e TSG8 asks to recalculate old (TSG7) TIR TSA
and TIR CLS scalars for the new MS8 reference
library
— It tries quite hard to preserve ancillary data

— Check your domain TIR RMS lists and TIR TSA / CLS
plots afterwards!



TIR Reference Libraries — MS7 (2015)

New

— Anhydrite

— Iron-rich Chlorite

— Volume-scattered Calcite

— Volume-scattered Quartz
Renamed

— Forsterite to Olivine-Mg

— Fayalite to Olivine-Fe

— Olivine to Olivine-FeMg
Deleted

— About 24 spectra, most of which were off by default in MS6

TIR TSA version bump —7.03 to 7.04
Settings -> Dbase; click “Update standard algorithm definitions”



TIR Reference Libraries — MS8 (2016)

New:

— Phengite (2)

— Glauconite (2)

— Kyanite (2)

— Sillimanite (2) (but on probation)
Deleted:

— Chlorite (NR-CHLOZ2, really serpentine)
— Pyrolusite (really cryptomelane)
— Marialite (fine-grained)

— Meionite (fine-grained)

Version bump, 7.04 to 7.05

Experimental MS8.1 (with other metamorphic silicates from Broken Hill)
available as an external library

Settings -> Dbase; click “Update standard algorithm definitions”



TSA 1/3

Andy Green’s TSA+ extension for SWIR TSA

— Uses independent feature fitting to guide TSA’s result
choice

o FeOH (2255), Prehnite (~1474), Amphibole (~2390), Epidote (fussy
~1550), Sulphate (~1750), Carbonate (TIR SAM)

— Fewer false positives with artefacts (notably plastic)
» Aspectral is reported instead, for low-strength artefact results

— Version bump, 7.04 -> 7.05

— “Plus” mixture choices are shown in Floater Overlay mode
— Always on for system SWIR TSA

— Optionally on for user / domained SWIR TSA

o Settings->TSA: v Lz the TSA PLUS method for user result selection



TSA 2/3

o Andy Green’s |CLST replacement for TIR TSA

— Uses SWIR TSA+ for guidance, for minerals that
respond better in the SWIR than TIR

— Uses other methods for guidance with carbonates,
guartz, talc, apatite, hematite

— Always on for system TIR TSA
— Optionally on for user / domained TIR TSA

° Settings->TSA: v Use the JCLST method for user results

— No floater support yet



TSA 3/3

* New scalars for spectral “strength”
— AspRat — Aspectral Ratio, pulled out as a scalar. (Big is “strong”.)
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— Tnorm — for scaling raw fitting weight to proportion. (Inverted; bigis
“strong”.)

Scope1 31028 20407 Points, r=0.281; Aux: TNorm dTSAT
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THorm dTSAT




Floaters

* Four floaters (all TSG8 installations)
« Afloateris not locked to VSWIR / TIR

* The interface has received some attention
B TSG Floater 1{primary dataset) (User SWIR TSA) MR L=liex
ez fOil@GeMi | B4 BR2E EMEO OO0
— Menu bar Is gone
— lcons for main options

— Intelligent right-click menu for other options (also available
from the “M” icon)

 PNG images are supported (“Pic” and “Map Pic”
modes)




Summary screen

e Overview plot
— Current sample markers
— Colour and sort tiles by any scalar (from same dataset)

— Sort bars large to small

e Domain editor link (careful) Scratchpad Send | B

E‘he best few samples from each overview bar will be
e

— Special scratchpad send SOl
(end-member collection) according to how it s st
°® S p ati aI p I Ot What size is "the best few™? JB—
send I Cancel |

— Better default bin size and higher bir=coarcmmmc
— Ribbon gets printed now!

e General
— Discrete reminder about system TSA (used to be indiscrete)



Scatter screen

Set Mineral and Set Weight virtual scalars are offered along with Set scope
Raster-mode Scatte_r_pIOt Scope 1:84956; 84956 Points, r=0; Aux: sSRGE Cclour from spectra
— Set X=Virtual Section, Y=SecSamp g & | s A S = s L

— Genuine raster render
— Labelled by Depth

Sec3a

7185
Depth (m)

Scatter-plot whisker overlays
— 11to 16 of them, or 1 per X-class

More line-fitting options (now 7)
Tamed “quick zoom™: double-click in the plot title area (not in the main plot area)
%+ Lasso button is always available

The colourbars can now be sorted in the same way as the Summary screen’s
colourbars

Histograms are sorted on overall class abundance; order matches the colourbar
Colour sorting is now offered for a true-colour scalar (works on hue * intensity)



PLS screen (1/3)

* New plot type — Correlation
— 2D synchronous correlation matrix
— Autopeaks plots (response change over concentration)

Autopeak

Autopeak [0.846, 10.85] (879)
Autopeak [10.85, 20.853] (256)
Autopeak [20.853, 30.857] (143)
Autopeak [30.857, 40.86] (57) -
Autopeak [40.86, 50.864] (14)

=
[+
[&]
m
]
[}

— 2D asynchronous correlation matrix



PLS screen (2/3)

New FRC overlay — input prediction details

Final Regression Coefficient (5 factors, final R*=0.926) Spec F
Sample 562 (mean sub), Act=27.99, Pred=26.752 E
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PLS screen (3/3)

« Selected (list or lasso) samples to scratchpad

 Actual vs Predicted plot: “SEP” now called
“RMSEP” and accompanied by a new readout
“BIAS”.



Checklist and Journal (1/3)

New toolbar button: mff

ﬁ:ﬁ Hylogging Checklist for 8446230_Borrowdale_2_tsg ) |
The CheCkl |St and JOU rnal Summary | Basic | TSA | Scalars | Domains & Piots | DBase | Joumal |
are stored in a dataset’s S
_TSG file N e
TSG Viewer can show the e NI ToA: Yo S e Yo

Rockmarks: NO Plots: Yes

C h eC kI I St Layouts: Yes Database: NO

Page 1. Summary
— Summary of signed-off e Bl eed Bl

.....................

C h e C kI ISt g ro u pS Copy to clipboard | Save to file

— Checklist and / or journal
reports to clipboard or
file




Checklist and Journal (2/3)

e Pages 2..6: Checklist
— 5 pages, 14 groups,
84 items!
— Basic HyLogging
workflow
represented

— Journaled signoff for
each group

— You shall comply

E:ﬁ Hylogging Checklist for 8446230 Borrowdale_2_tsg S

Summary Basic ITSI-'-. ] Scalars ] Domains & P'Iu:lts] DBase ] Ju:uumal]

[ Level Ofiles have been archived
“Final Mask” (Rock Mask) Scalar
[ Full fnet sub) Kahuna was n v Created from "Kahuna'
¥ Checked jesp. 'off spans) v Dilated and edited
¥ Advanced (C / spot-editing ¥ Signed off by anatyst
Depth Logging
|IW Init. / reset from ‘Final Mask’ ¥ Section bounds revised
¥ Depth markers ertersd v Cracks & space checked / marked
W Missing core marked {w. depths) W Full recoveryate GC check
| Exported to text file Iv Signed off by analyst
Imagery
¥ Al linescan viewed v linescan width4rimming done
W Tray-screen colour optimised W Standard tray pics created
W Mosaic pic created ¥ Hole-screen pics created
| Map pics present and working Iv Signed off by analyst

Ok | Cancel




Checklist and Journal (3/3)

Page 7. EventJournal

Various sorts of changes to a
dataset are logged by TSG

Most entries are logged
automatically. (The exception:
optional analyst comments.)

Date / time, TSG site & version,
and username are recorded
against each event

The display can be filtered by
category /priority, and is
coloured by priority

Entries cannot be deleted

rim Hylogging Checklist for 8446230 Borrowdale 2 tsg

|

Summar'_.r] Basic ] TSA ] 5|:alars] Domains & P'Iu:lts] DEase Joumal l

"SI New [ Mod [V Other Level: |&y
Time Description -
20150710 09:05:04 Created, dataset version 7.190000
201540710 09:05:14 Import method: Hylogaging PO Tray, outpu
20150710 09:05:14 Criginal scan date: 20140703 13:11:27
200540710 09:05:14 Predigested4ray impart: TS5A update requi
20050710 09:05:14 Predigested4ray import: Update of datase
E]EE-'IB—E'?-H} 059:05:15 Created, dataset version 7.190000
DEI}'I 5-07-10 09.05:17 Import method: HyLogging PO Tray, outpu
[:'21}1 5-07-10 09:05:17 Criginal scan date; 2014-07-03 13:11:27
D}Hﬂ 50710 09:15:28 Recalculating assoc TSA, Sys TIR | versic
200150710 09:45:44 Created new scalar prof_min
20150710 09:55:23 Created new scalar sec_end_mask
201540710 09:55:37 Created new scalar Kahuna (standard) b
] I b

o]

Cancel




External Libraries

Advanced support that requires suitably
marked-up spectrum names

New linking procedure to associate library
samples with TSG’s table of “known minerals”

t starts with an updated “Attach aux”
Domain RMS editing
Domain-RMS-subsetted CLS results
-loater TSA and CLS support




Downsampler (1/2)

New option — spectral downsampling.

— Supported in unsupervised mode; good for jobs like batch resampling to HyMap
— More options than in TSG’s import (e.qg., filter-function library)

1aryeL
Format ©~ Simple € wwl ©° wvl, FwHM €7 (ENVI) % Filter func.

File |C:'n,DDme'-,Dcust'n,Tum'-,asterﬂr.lE.hdr Pick
555.08 to 11281 nm; 14 chans (2 active); non-inear

Units are |Nan|:|metres j Active channels |

Range | 555.08 to | 2500 |

— Several resampling methods

oy

Mearest neighbour sampling
Linear interpolation

Spline interpolation
Gaussian convolution

Lanczos interpolation

Ty T3 Ty )

Diynamic frequency-space Lanczos interpolation
~

— Result does not have to be at fixed channel spacing



Downsampler (2/2)

* New sub-option — direct batch-scalar calculation
on resampled spectra

— Supported in unsupervised mode; useful for certain
workflows.

— Works directly on resampled spectra (arbitrary
channel spacing)

— Most batch-script methods are supported. (“Import”
and “FeatEx” currently aren’t supported.)

— If this sub-option is used then the resampled spectra
don’t have to be saved



Image export

* PNG format for general JPEG mage Flee C47G)
graphics export

Windows Bitmap Files (*. BMP
(supplements BMP, JPG 1
an d E M F) Tray picture generation li_z-,

1Tray, 3 sections, pixels per metre=15500

o Uncompressed linescan | cowent: © plin © Liesaeen & image st
from Downsampler Ouput: ' PEG C Bitmep @ PNG

— ENVI |mage OUtpUt Output resolution (pixels per metre): | 2000
— Requires no chaperone

« Section and Tray image
sticks from Tray screen

Extra section width trimming (%:); |0

Resampling: |Windows default {fast) ]

One stickper: ™ Tray {  Section [ Horiz.



Batch mode (1/4)

MULTIOPTIONS noassoc nodive
multifile c:\OOme\swift\*_*
task begin

operation update

update i1tems all

task end

BER C\Windows\system32ycmd.exe

C:sBdmessuift>"'C:“Program Files (x86>~The Spectral GeologiststsgeolB' Azcript=te
stzcript3_txt

BT

e Old Skool! (2015)




Batch mode (2/4)

TSG runs in the background without showing
any windows or dialogs.

TSG runs one or more tasks specified in a text
file.

TSG can run the tasks on each dataset found
by a wildcard file match. It can traverse
nested directories. There are some options to
restrict the matching.

A log file records what was done.



Batch mode (3/4)

Database upload

— Some checking options (e.g., user TSA present)
Database download

— Single dataset only — multi-file system not supported
Dataset update

— Some options on what to update: dataset format; specific system and user
TSA result sets; SWIR and TIR CLS result sets

Copy processing
— Works according to a template TSG dataset
— Options to copy scalars and / or layouts
— Can include the dataset update task (run first)
Downsample
— Works according to a configuration script saved from the downsampler
— Option to override output directory (e.g., one directory for result collection)

— Some options for tolerance (e.g., carry on even if some config scalars aren’t
found)



Batch mode (4/4) (2016)

Hasta la vista, command line! TSG can schedule unsupervised jobs. File ->
Special -> Schedule a script for unsupervised TSG.

The Downsampler’s new functionality is supported.

Datasets can be opened read only (i.e., no TSG7->TSG8 update forced / required)

New task: Testrocks

Works on one or more VNIR-SWIR Testrocks datasets
Datasets can be opened read-only
Uses a profile method to find feature positions

Reports on feature positions for one or more of: mylar (7 features); pyrophyllite (6 features);
kaolinite (3 features); talc (11 features)

Collates results in one table.

New task: “Kaolin” wavelength checker

Works on one or more general VNIR-SWIR or TIR datasets
Datasets can be opened read-only
Uses TSA to filter candidates, then uses a profile method to find feature wavelengths

Reports (wavelength, Std. Dev.) on kaolin 2160 or 2206 for VNIR-SWIR; Quartz 8625, Quartz
12625 or Apatite 9200 for TIR

Collates results in one table



Drag & drop

Opened up considerably

Main TSG window now takes one
TSG file (open); multiple TSG files
(merge); PLS file; identifiable
import files (e.g., pdtray.TSG, SDS,
SDF, HDR, DSP, SED, CSV)

Floater takes TSG (aux); HDR
(scratchpad); STA (stats)

Most dialogs that have file selection
(e.g., individual import-wizard
pages) take files or directories




Keyboard support

Many “keyboard accelerators” (hotkeys) now

TSG main window and Floater windows have
their own sets of keyboard accelerators

Tray screen’s depth-logging tool has its own
keyboard accelerators

One or two special accelerators (<CTRL><DEL>)

See Help -> Keyboard accelerators - Or press
<ALT>F1!

Most plots that have a sample marker or a sense
of “the current sample” understand arrow keys



Scalars

New batch-script method
aux match

New Profile scalar result -
relative peak height

New Profile scalar result —
relative range

New Pfit scalar result —
relative range

New HyLogging import-
time scalars

pl = auxm, layer=REF, auxlib=tmpl.tsg,
algo=correl, method=names, level=group,
localbkrem=yes, minscore=0.9,
wminl=2100, wmax1=2450

Like relative depth but for
peaks (TIR)

(max-min) / mean

Poly de-trend;
(max-min) / mean

Virtual Section and PFit
Relative Range



Import

New format supported — CSV table of spectra
— Spectra in columns or rows
New format supported — TerraSpec (ASD) HALO
— Project file includes scalars that can be selected for import
— Concept can be used more generally (i.e., without a HALO)
New format supported — Spectral Evolution oreXpress
— Custom option in TSG’s ASCII XY import

“TIRSampShift” aux-file kludge for adjusting HyLogger3
TIR alignment in the SDS import
— Whole number (times 4mm samples), + to push TIR down,
- to pull up

HyLoggerl SDF import supports the TIR datastream



Settings (1/4) — TSA (2015)

Interval list includes all TSA result | = 6 Settings - e
sets in a dataset pair. G2 | System | SpecCales | TSA | Featix| Dase |
New dialog button brings up the (rterval JUSF_TSA_SWIR (dtoset soect =] Mask: B ®
new-style list for active mineral Trairing parameters
selection. (Old dialog is still T I U =
there fOf the tl’adltlona“StS) Select the level at which to match items: | |-noise calc parameters
~ Right-click menu! ¢ somonarimia e amhs
— Cross-region multi-level import / ||« winerai a2/ 52/ 52) o b
export :: Spem::” {EHETT”Z | 1275 SRsSth. [1000
Force system recalc is new. T S | .
(ln the >[i;ast there jUSt was i Caneel| SNR th. |60 Weight th. |0.15
“force recalc” for user TSA.) o e I — b e
Domaln SUb |S not neW’ but the W .lj Domain su‘l:l‘ .5 Active mineralg New dialog J) Cid Ilelh.‘JQJ
TSA Scalars |t glves you are now Ca’[egunsefallu:& e .Jus‘t MULL & NULL and aspectral  Various
SeLaJIIed”“Domained” instead of e defat stinge 1 o
ser”.
Cancel




Settings (2/4) — TSA (2016)

e TSA Settmgs Reorganised!
EﬁTSGSethngs |

Gi1 | Gix2 15ystem]5pecﬂalcs TSA ]FeatEx] DBase | .

TSA result set Advanced TSA Settings . [

Masked by QFinaI Mask @ ¥ Llsethe TS

Training parameters

Modure level [Mix 1.2 v lambda [0.09  [0.01 Prop | 1 ™ Mineral
Min. tem weight (%) [0.15

Advanced thresholds

Signal-to-noise calc parameters

Bump width | 30 Avg. res, | 4 Quant. | 0.5

W Use the TSA PLUS method for user result selection o
Unmixing parameters

[ Limit active minerals according to Domain RMS lists
5 Albedo th. | 0.04 Aspectral th. | 1.275 SRSS th. | 1000

11 Active minerals Select active minerals I

M.LL. th. | 0.45 SMR th, | 60 Weight th. | 0.15
Categorise failure ¢ Just NULL @ NULL and aspectral { Various S . ] 1275 Aisto s | 1 v Tlites
Restore default settings ] Allowed minerals and Mixtures |
[ Mark for a system recalc [T Mark for a user recalc ITI

5
Ok | Cancel




Settings (3/4) — Gfx1

« Use TSA abbreviations gives | = 5sns o

more legible colourbars in L | Loien| S s [ AT e ke
TSA_COIOU red pIOtS. Base font size: Iﬂ W Scaletoplot height W Scale off-screen
. Cursortext size: |'IE "]
* The ChECk on flne Colourbar width: [8  «| [~ Clip blocks W NULL block

histograms now applies to Colousberfors: [13 AL Use TSA shbrevisions)
the Spatial Summary-screen || seoipase tosi: 100 <]

p I Ot too (n OW that It Can Colour reporting: iHexau:Ie::irnal BBGGRR L]
: v Black-on-white for screen plots Iv Black-on-white for prints & files
h ave m any m O re b I nS) - ld-style clipboard copy fmages) [ Plot wavelengths in nanometres
° Th ] t t I k 60 naot plot histograms that are too fine to display property
e re S a n eW O p IO n O OC Global scale for floater in spectrum mode {on new tiggers)
th e Sam p I e m arke r ’S Scatter guick-zoom (double-click in title or axis area)
. t th en scrolling. toy to hang on to the curent-sample selection
pOSI IO n O n e SC ree n JPEG file output quality: I_a"'.i-— Scaling (% of screen): ]T

when scrolling the Log and
Stack screens.

QK Cancel




Settings (4/4) -

Remembering window
positions is optional.
— Watch out for that layout list

selection (groundhog day
experience).

“Switch to Viewer” has been a
useful option for side-kicks
with lesser licenses (to turn
off), and is more relevant in
TSG8.

CSCN is new.

The default Log-screen set-up

has changed, but you can have
;f(l:(olour by weight” back if you

ike.

Gfx2 and System

Plot layouts
| Use the saved window sizes and positions {which might not travel well)

Load this one on dataset open: |T|E||:|'rti|:|nal [view when last closed) j

Gix1 | G2 System | Spec Cales | TSA | FeatEx | DBase |
| Dn startup, check the intemet for a TSG update:

Remember [ast directory selected | Clear recent files list
witch to Viewer if given a dataset with unlicensed components

On dataset open, check spec calc settings against defaults

[v On dataset open, offerto upgrade old TSA scalars
| Copy .BIP file on open

Iv Copy some screendayout information in "copy processing” (mport)
| Copy TSA user settings in "copy processing” (existing dataset)
v |SCH (interactive scalar construction nanmy)
@SCN [copy-processing scalar construction nanmy)
For TIR scratchpads, source layer = TempComr Refl
| Euro-style CSV handling for both import and export)
Run the floater window in a separate thread
@ standard log-screen set-ups, colour TSA by weight

earch radius for common minerals look-up {nm):; 10



Other dialogs (1/8) — Domain editor

Domain editor

Boundary field is strong red if —

E Domain Editor

]

Prewv I o2

on a masked-on sample
Nav dot is red if current

b

sample is masked off
The first 2 characters of the

Current sample=20373, depth=145.29

|Colour R | o

e Elm, 23509:33999

Start v Linkg{ 180610 (114) mﬂw
End ¥ Linked [23508  (163)  curr | Goto|
G|255 B|255 i

D3

domain name are managed
by the system. You can enter

your own text after that. /

The description field is still

yours to play with

New dynamic, colour-coded /
domain sub-group list (VNIR,
SWIR, TIR)

What'’s that? (See next page\

[Quartz Wica

?\ Quartz W-Mica
=
o

SWIR 2 active

1\

VNIR 0 active

TIR 5 active

Copy attributes I Delete |

ey

| N

o § Merge above I Merge beluwl

¥ Export I Auto TSA | EE

Close




Other dialogs (2/8) — Domain editor

Export domain info

e Domain editor — Export e —

Columns | Groups v Sub-groups | Minerals

— CSV Summary of a TSA or iR R

CLS result set _ Fie: | [CrDOmeVenifi14593_PDBOMS1ME_5ed Bk
— One row (or column) per (2=l e
domain; normalised 005583 35.99883] 35,500 0006297 0375
percentages ] e el s oo

— Click the File button to
toggle itand get a
clipboard copy option.



Other dialogs (3/8) — Domain editor

Domain Exported Domain Properties Formats

Domains downwards Minerals Across, or vice versa. Groups or Groups &
Minerals for each spectrometer, i.e. 3 csv files, e.qg:

Name Red
D1 Arthur
D2 Lower.,
D3 Thorntt
D4 Red He
D5 Upper |
D6 lwr b'rr

D7 lower k

0
95

255
255
141
255

255
26
255
0
255
71
0

Blue

>

71.45943 0.34912 18.45662

6.129785
99.17847

0 93.34374
0 0.610185

48.37985 3.698447 4.773605
1.304117 0.039613 1.348784

0.006546
0.070546

0 3.97463
0 3.550925

Descriptiol From_San To_Sample From_Dep To_Depth WHITE-MI SMECTITE OTHER-AL CHLORITE DARK-MIC AMPHIBOLEPIDOTE CARBONA SULPHATE INVALID
0 Carb Qtz 0 26959 334.5 523.9068 2.552116 0.259131 0 0.727725 0.001518 0.002205 6.192138
255 Qtz carb | 26960 29428 523.9068 541.4591 0 0 0 0.104004 0 0.029344 0.393134
255 Quartz Sm 29429 34568 541.467 578.3665 0.081672 0.065028 0 0.055067 0.009571 0 0
255 Quartz K-F 34569 38190 578.3745 603.3914 38.13964 1.029442 0 2.705094 0 0 1.273922
0 Quartz K-t 38191 51207 603.3989 693.6895 21.2218 1.027984 0.813107 45.43991 2.547068 19.80014 6.457474
71 Quartz K-F 51208 54572 693.6973  717.25 4.890872 0 0 22.89012 37.63008 8.388073 22.21968
128 Quartz K-f 54573 60749 717.2578 760 6.508453 0 0.058844 23.04057 23.50904 37.40708 5.854541
Name D1 Arthur Creek Frr D2 Lower Arthur Ct D3 Thorntonia Lst D4 Red Heart Dolo: D5 Upper basemen D6 Iwr b'ment with D7 lower basement
Red 0 95 0 255 255 141 255
Green 255 26 255 0 255 71 0
Blue 0 255 255 255 0 71 128
Description Carb Qtz W-Mica Qtz carb possibly Quartz Smectite- Quartz K-Feldspar Quartz K-Feldspar Quartz K-Feldspar Quartz K-Feldspar
gypsum. Bad vol  white mica. Bad Al Carbonate-Mg- Carbonate-Mg-Ca Albite W-Mica Albite W-Mica Albite W-Mica
scattering impacts vol scattering Ca Apatite. Carb  Gypsum Apatite  Prehnite Chlorite Chlorite Dark- Prehnite Chlorite
carb & qtz. Lower impactscarb &  W-mica. Vol W-Mica Smectite- Amphibole-Ca Micas Amphibole- Dark-Micas
part goes qtz. Mostly scatteringonqtz Al Epidote Ca Epidote Amphibole-Ca
aspectral in SWIR aspectral in SWIR etc near 8200 nm. Carbonate-Mg-Ca Amphibole-Na Epidote
with increasing due to organics.  Not vonsenite! Gypsum Amphibole-Na
organics. Contains Apatite-rich sandy Carbonate-Fe-Mn-
From Sampe 0 26960 29429 34569 38101 51208 54573
To_Sample 26959 29428 34568 38190 51207 54572 60749
From_Depth 334.5 523.906799 541.467041 578.374512 603.398926 693.697266 717.257813
To_Depth 523.906799 541.459106 578.366516 603.391357 693.689514 717.25 760
WHITE-MICA 2.552116 0 0.081672 38.139637 21.2218 4.890872 6.508453
SMECTITE 0.259131 0 0.065028 1.029442 1.027984 0 0
OTHER-ALOH 0 0 0 0 0.813107 0 0.058844
CHLORITE 0.727725 0.104004 0.055067 2.705094 45.439911 22.890123 23.040571
DARK-MICA 0.001518 0 0.009571 0 2.547068 37.630081 23.509041
AMPHIBOLE 0.002205 0.029344 0 0 19.800138 8.388073 37.407078
EPIDOTE 6.192138 0.393134 0 1.273922 6.457474 22.219679 5.854541
CARBONATE 71.459427 6.129785 99.178474 48.379852 1.304117 0.006546 0.070546
SULPHATE 0.34912 0 0 3.698447 0.039613 0 0
INVALID 18.456615 93.343735 0.610185 4.773605 1.348784 3.97463 3.550925



Other dialogs (4/8) — Domain editor

These can be edited and formatted in Excel
and/or exported to a traditional logging
package and copied directly into your drill

hole report or paper

D2 Lower Arthur D4 Red Heart D6 Iwr b'ment D7 lower

Crk black shales Dolostone with f'spar+biot & basement
Name less amph
From_Depth 334.50 523.91 541.47 578.37 603.40 693.70 717.26
To_Depth 523.91 541.46 578.37 603.39 693.69 717.25 760.00
Interval 189.41 17.55 36.90 25.02 90.29 23.55 42.74
WHITE-MICA 261 0.0 0.1 38.1 21.2 0 490 6.5
SMECTITE 0.3} 0.0 0.1] 1.0 1.0] 0.0/ 0.0
OTHER-ALOH 0.0l 0.0 0.0 0.0 0.8/ 0.0l 0.1
CHLORITE 0.71 0.1 0.1} 2.7 45.4 Il 22.9 Il 23.0
DARK-MICA 0.0l 0.0 0.0/ 0.0 2.5 Ml 37.6 [l 235
AMPHIBOLE 0.0l 0.0 0.0/ 0.0 19.8 8.4 M 37.4
EPIDOTE 6.2 0.4 0.0/ 13 650 22.2 5.9
CARBONATE 715 6.1 99.2 Il 48.4 1.3] 0.0} 0.1
SULPHATE 0.3] 0.0 0.0 3.7 0.0] 0.0} 0.0
INVALID 18.5 I 93.3 0.6/ 4.8 1.3 4.00 3.6

In this case the long descriptions have been removed




Other dialogs (5/8) — Domain editor

e New button - Init
— You can initialise domains from a class scalar’s boundaries
— You can also do an “Auto TSA” initialisation here.

— If you do both, the Auto TSA part is done in a special way — class
superset RMSes.

Domain Auto-start @

E_

This toaol can help get you started with domaining a data-set.

Step 1: Initizlise domains and their boundaries from an existing dass scalar,
You will need a suitable dass scalar of your own.,  WARNING: This will
completely reset the ALL of data-set's domain information.

W Initizlise boundaries from dass scalar 8 Formation &

Step 21 Initialise domain Restricted Mineral Sets from user (if present) or
gystem TSA scalars.  WARNING: This will reset all Restricted Mineral Sets.

| Initialise Restricted Mineral Sets from TSA

- Proceed I Cancel I




Other dialogs (6/8)

e File -> Dataset |nf0, = 14993 DD8BMS1 Mt Sedquick tsg ==
“Metad a‘ta" tab Metadata lSizes l Description ] TSF-.Summar}r]
Hole name | dd88ms1_mt_sedgewick  Logger [HyLoager 3-6
— Contents now saved to and S en
loaded from the NVCL Owner|
database At
— Pink fields might have Driled [-12015-0209 0736 | Scanned [[¥:201211-2715:49 ~ |

proper counterparts in the Latitude [0000000 Long [00000D  Daum[T
borehole database; edits zimth [0.000000 nci 0000000 RL[0B0000D

In TSG may be overridden

— If your borehole info is OK Cancel
valid then you can load the *
pink locational fields from e sy s s

the bo re hOIe database This dataset has a database entry. Load From WFS




Other dialogs (7/8)

e Depth logging
— The right-click menu has a new option called “Missing interval

marker”. It brings up a dialog that will help you deal with those
markers that just report something like “0.44 m missing”.

Missing-interval iﬂc&_‘ &J

I take it that you have sorted out all the section bounds
{land ordinary depth markers for this fray, and have now
right-clicked on one of the 'space’ samples near the middie
of a mysterious missing-depth-interval marker.

| The endosing interval {with ordinary depth-marker 'book
ends’) has a depth span of 0.975 m.

| Take a bite out of that. Tell me the missing depth interval
|| that iz written on the marker.

Missing depth interval (m): | 0

Calculate bracketing depth markers | Cancel |




Other dialogs (8/8)

Vertical Lines s &

e Vertical Lines

— Buttons for easy access

« Scalar Names and Groups

— Both datasets

e GoTo
— Both datasets

W on Rad 15 | -
L& 1782
Label: 17 -

Wrinot: |
Clear all ines I Templates Close |
-
Scalar names and group
{* Primary Dataset " Associa ted Dataset
E Sechamp o,
L2 Secti .
.
Goto

€% RockMarks = |= - | 6173: Some

thing

----- [Switch to secondary dataset...]

B HylLogging

E% Locations
Pl nanth feed

v

ticky

Eil




Miscellaneous (1/3)

iﬂ T5G Floater 1 (associated damﬂﬂ_'

* Red plot titles X EL ] IRICPIE

ONTE 1403 DOEEM 31_Mt_Seogewick M021_278 T=021 L=3 P=10 D145 289527 X—To 0001

— Single-sample plots have a
If their sample is off

In final_mask , |

’ I\/I e rg e Spectra: |Cnmmun interval=380to 2500 step=, nm4; your #chans=531
— The Merge module is more S e - O

Assoc: |Cnmm|:|n interval=6000 to 14500 step=, nm25; your Hchans=341

tOIerant’ and deals Wlth Resamp: 5000 to: [ 14500 by: |25
dataset pairs PP S S

() Floate r Stats mOde Export Transformed Spectra 38 -

ask {0k Final Mask &=
— can export transformed M, |m_Fﬁ| : ,
spectra to a CSV table e =

E]q:lﬂri Cancel I




Miscellaneous (2/3)

New colour tables with fringe focus
— “Mirrored rainbow” and “Dead centre”

— Reduced visual impact for mid-range values (e.g., good for spectral derivative
plots)

Change to default Scatter-screen layouts
— “Set” group scope coloured by Set Mineral
Change to default Log-screen layouts
— No spectral columns!
— Depth instead of Index
— TSA “coloured by weight” off by default (Setting)
Downsampler tweak
— Silent profilometer inclusion when downsampling on Index with a bin size of 1
Layout manager
— Spinner control to change layout order



Miscellaneous (3/3)

ENVI import

— A *“bad bands list” (individual channels marked as dud) is quietly supported.
Bad bands are automatically excluded from the import and interpolated over.

SDS import

— Lossless (PNG) image import is supported (but the HyLogger currently
struggles to keep up). Active use tba

Linescan image magnification loupe
— Tray and Log screens
— It works with a mouse that has a “wheel” middle button.

— Middle-mouse-button down to bring up the loupe; roll the wheel to adjust
the magnification

Tray pic generation — image sticks
— You can now create one stick per depth interval, e.g., one stick per 1.5 metres
— Width trimming now works on them
— You can discard unwanted intervals by using a mask



A few reminders

Settl ngS -> Dbase Update the database’s standard algorthm definitions NOW |
— Once, sometime, for TSGS.
1 - LUTs for spectral colouring
Settl ngs > Gfxz Spectral layer: | Reflectance j LUT: |TSG rainbow j

— Maybe | can use those new mirrored
colour tables on my Derivative layers?

Scalar Names and Groups Reset colour [Leave asis v

— Now | remember. Funny how the list
changes depending...

S Ca.l ar CO n St r u Cti O n Wi Za rd Host dataset: * TestRocks_1_tsgtray (" TestRocks 1 tir_tsgtray

— There’s something plain awkward
about this one

Scalar construction — CLS svects [PHR=)
— There’s something interesting here




